Magnus Gustafson, Göran Skantz

iWarf - a Service Creation Environment
iWarf - a Service Creation Environment

Magnus Gustafson, Göran Skantz
This report is submitted in partial fulfilment of the requirements for the Bachelor’s degree in Computer Science. All material in this report which is not our own work has been identified and no material is included for which a degree has previously been conferred.

____________________________________
Magnus Gustafson, Göran Skantz

Approved, 2001-06-05

____________________________________
Advisor: Hannes Persson

____________________________________
Examiner: Stefan Lindskog
Abstract

This C-grade Bachelor’s project is written for the Department of Computer Science at Karlstad University and for the Karlstad company Incomit, spring term 2001. The background for this work is the need of a certain service creation environment for making development of telecom and Internet services easier and the main goal is to create a prototype for this. Service developers, who will create the telecom services of tomorrow, will use this service creation environment. The environment is based on the modular open source IDE (Integrated Development Environment) NetBeans. New features have been added to the environment to make it easier to create telecom and Internet services. The development has been done mostly in XML (eXtended Mark-up Language) and with the JavaBeans™ components architecture.
Acknowledgement

We would like to start by thanking our University supervisor, Hannes Persson, for helping us writing this document and pushing us to really start in time. Special thanks goes to our company supervisor, Pär Larsson, together with Marwan Semaan and Håkan Spjuth at Incomit for giving us the support we needed and making this Bachelor’s project joyful.
Contents

1 Introduction ............................................................................................................................ 1

2 Background .......................................................................................................................... 3

2.1 iSea .................................................................................................................................. 3
2.2 iSluice ............................................................................................................................. 4
2.3 SLEE ............................................................................................................................... 4
2.4 Problem ........................................................................................................................... 4

3 Purpose and requirements .................................................................................................... 5

3.1 Purpose ............................................................................................................................ 5
3.2 Requirements ................................................................................................................... 5

4 Preliminary investigation about choosing an IDE .............................................................. 7

5 Description of the system design ....................................................................................... 9

5.1 Graphical User Interface design ..................................................................................... 9

5.1.1 Incomit menu
5.1.2 Palettes
5.1.3 Templates
5.1.4 Other graphical design parts

5.2 Functional design .......................................................................................................... 11

5.2.1 Incomit menu
5.2.2 Palettes

6 Implementation – NetBeans development ........................................................................ 13

6.1 NetBeans architecture ................................................................................................... 13

6.2 Modules .......................................................................................................................... 13

6.2.1 The manifest file
6.2.2 Layer file
6.2.3 Installation

6.3 Templates ....................................................................................................................... 16

6.3.1 Template files
6.3.2 Layer file – create the template
6.3.3 Resource files
6.3.4 Bundle file
6.3.5 Adding external libraries to NetBeans

6.4 Palette – create the drag ‘n’ drop feature ...................................................................... 20
6.4.1 Layer file – create the palette
6.4.2 The manifest file – specifying the palette component
6.4.3 The component
6.4.4 Final installation

6.5 Wizards .................................................................................................................... 24
6.5.1 Wizard files

6.6 Menus and actions....................................................................................................27
6.6.1 Actions
6.6.2 Menus

6.7 Filesystem example..................................................................................................31
6.7.1 Simple example

6.8 Other...................................................................................................................... ...33
6.8.1 Changing the start-up logotype
6.8.2 Changing the coordinates of the text in the start-up logotype
6.8.3 Changing the window title.
6.8.4 Add code to the parser database (code completion)

7 Use case – Create and deploy iSea SLEE Client.........................................................35
7.1 Environment.............................................................................................................35
7.2 Templates .................................................................................................................35
7.3 Palettes ................................................................................................................... ..36
7.4 Coding..................................................................................................................... .36
7.5 Descriptor Wizard ....................................................................................................38
7.6 JAR-packaging .........................................................................................................39
7.7 Deploy to iSea ............................................................................................................40

8 Problems and experiences............................................................................................43
8.1 Problems................................................................................................................... 43
  8.1.1 NetBeans related problems
  8.1.2 Implementation problems
  8.1.3 Incomit related problems
8.2 Experiences ..............................................................................................................44

9 Conclusions ..................................................................................................................45

Terminology and abbreviations ......................................................................................47

References....................................................................................................................49

A Requirements specification ..........................................................................................1

B Code ............................................................................................................................1
  B.1 iSeaClient_java .......................................................................................................1
  B.2 ECall.java .............................................................................................................2
  B.3 HelloWorldPanel1.java ......................................................................................3
  B.4 HelloWorldPanel2.java ......................................................................................6
B.5 HelloWorld.java ........................................................................................................... 8
B.6 HelloWorldWizardAction.java ...................................................................................... 12
B.7 Example.java .............................................................................................................. 13
B.8 FileExampleAction.java ............................................................................................. 15

C Descriptor wizard steps .................................................................................................... 17
List of Figures

Figure 1: iSea and iSluice overview ................................................................. 3
Figure 2: NetBeans and Forte roadmap ......................................................... 8
Figure 3: NetBeans GUI ................................................................................. 9
Figure 4: iWarf – Menu and palette .............................................................. 10
Figure 5: iWarf splash screen ...................................................................... 11
Figure 6: Result from the layer file .............................................................. 15
Figure 7: Setting up module directories ...................................................... 15
Figure 8: Setting up template directories .................................................... 16
Figure 9: Setting up component directories ................................................ 22
Figure 10: Explorer view ............................................................................. 22
Figure 11: BeanInfo editor .......................................................................... 23
Figure 12: The complete step 1 in the wizard ............................................. 24
Figure 13: Wizard directories ..................................................................... 25
Figure 14: Wizard Panel 1 ........................................................................... 25
Figure 15: Complete step 2 in the wizard ................................................... 26
Figure 16: Menus and actions directories .................................................... 28
Figure 17: Filesystem directories .............................................................. 32
Figure 18: Choosing the template .............................................................. 35
Figure 19: Project name .............................................................................. 35
Figure 20: Project package .......................................................................... 36
Figure 21: iESPA palette ............................................................................ 36
Figure 22: Component inspector ............................................................... 37
Figure 23: Code completion ...................................................................... 37
Figure 24: File structure .......................................................................... 38
Figure 25: JAR contents ............................................................................ 39
Figure 26: Adding files and directories to the JAR contents file ............... 39
Figure 27: JAR contents properties ........................................................... 40
Figure 28: How iWarf and iSea are related ............................................... 41
1 Introduction

In these days, telecom and Internet are really common things in everyone’s life. We use a lot of services and take them for granted. The most common services available today are simply WAP (Wireless Application Protocol), messaging and calling services but the possibilities of tomorrow are far beyond these. What about setting up your own conference calls, receiving information depending on where you are or choosing to call the nearest taxi by just clicking the taxi button on your PDA (Personal Digital Assistant). What we really do not think of is how these services are created. Today at the Karlstad company Incomit, services are created from scratch with a common editor. What happens when Incomit will ship their products and their customers need to create a service? Probably it will take hours to create even a simple one and this is not really a good sell argument. Therefore it would be a lot easier with some sort of service creation environment with certain Incomit features. This Bachelor’s project is about creating a prototype for that environment.

Chapter two explains the background of this Bachelor’s project. In chapter three the purposes of this Bachelor’s project and the requirements of the software are listed. This Bachelor’s project includes a preliminary investigation about choosing an IDE, which can be read in chapter four. The prototype design, described in chapter five, can be divided into graphical and functional design. Chapter six brings up the implementation, which is the main part of this Bachelor’s project. Here the reader will be given a thorough description of how to modify the IDE. Furthermore, chapter seven contains a use case that shows the prototype usage. Then in chapter eight, experiences and recommendations are discussed and then finally in chapter nine conclusions are presented. After these chapters follows a section with terminology and abbreviations and then a section with references.
2 Background

Incomit AB is a producing company with their main office in Karlstad, Sweden. Incomit is a growing company with approximately 35 employees. Incomit’s business concept is to integrate the mobile telephone network and the PSTN (Public Switched Telephone Network) with the Internet. Their two flagship products are iSluice and iSea. iSluice is a server that runs within the PSTN to give iSea servers access to the telecom network. iSea can be classified as an application server that can execute different types of services, such as conference call or positioning mobile phones, and in a safe way communicate with iSluice. As seen in Figure 1, it is possible to communicate with iSea using WAP or HTTP (Hyper Text Transfer Protocol) through a portal.

![Figure 1: iSea and iSluice overview](image)

2.1 iSea

iSea is a platform that enables service developers to quickly create advanced telecom-based services and make them accessible in an Internet environment. iSea consists of many different components, both hardware and software. Incomit develops some of the components and some are bought and integrated into iSea. This way of working is possible thanks to products built on open systems and commercial standardized interfaces.
2.2 iSluice

iSluice is the “sluice” an operator must have in the network to permit secure and reliable routing of externally initiated iSea services (as from Internet portals). iSluice enables today’s operators to increase the usage of their networks by attracting Internet portals and other companies to develop services. iSluice allows iSea servers to access the telecom network in a secure way.

2.3 SLEE

The SLEE (Service Logic Execution Environment) is an execution environment. Both iSea and iSluice are based on a SLEE. The difference between iSea and iSluice is the services running in the SLEE. For more information see the SLEE API specification [5].

2.4 Problem

Today all iSea services are developed in Java™. This works fine but it demands a lot of competence, both in iSea API’s and Java™. An important issue for making profit from iSea and iSluice is to offer Incomit’s customers a tool that has features to simplify the making of iSea services. How do one measure the simplicity of a tool? This is a problem, because it is difficult to measure simplicity. An important factor is the time it takes for a developer to make a service from scratch to have it running in iSea. Our assignment was to make a prototype for such a tool. The prototype was based on an existing development tool, which was changed to fulfil Incomit’s needs better.
3 Purpose and requirements

Below follows the purpose of this Bachelor’s project and the requirements specific to the prototype. The prototype will be the foundation of a commercial product that is to be developed the summer of 2001.

3.1 Purpose

The main purpose of this Bachelor’s project is to create a service creation environment, called iWarf, which makes it easier to develop telecom and Internet services. This means that it will be possible to create services faster than without the environment, which might be the small difference between coming in first or second place on the market because of the exaggerated tempo. It also means that fundamental knowledge of the Java™ language will still be necessary but not all about the underlying structure and this will simplify the developing.

3.2 Requirements

The requirements for this Bachelor’s project are gathered in the Requirements specification in Appendix A. For more specific information, please read that Appendix.

3.2.1 iWarf requirements

Below follows the requirements specific to iWarf.

1. Create an Incomit service project
2. Create a specific Incomit servlet project
3. Create a specific Incomit client project
4. Investigate which development tool to use
5. Create an ESPA (Easy Service Provider API) palette.
6. Create an Utils palette.
7. Drag 'n' drop Incomit iSea Call Control service
8. Drag 'n' drop Incomit iSea Messaging service
9. Drag 'n' drop Incomit iSea Positioning service
10. Drag 'n' drop Incomit iSea DB service
11. Drag 'n' drop Incomit iSea Log service
12. Drag 'n' drop Incomit iSea Trace service
13. Incomit menu
14. JAR (Java™ ARchive) Packager
15. Deploy to iSea
16. Help files
17. Create a service using iWarf

3.2.2 Other requirements

Some documents had to be written to accomplish this Bachelor’s project and these are:

- Requirements specification.
- Technical documentation. A SDS (System Design Specification) containing information specific for the Incomit crew.

There were no delimitations of this Bachelor’s project other than the requirements specified above or in the requirements specification.
4 Preliminary investigation about choosing an IDE

The recommendation from the company supervisor was that Sun’s Forte™ should be used as underlying foundation when creating the service creation environment. We first built iWarf upon Forte™. When problems occurred no useful information about Forte™ could be found but since Forte™ is based on the NetBeans IDE, everything needed could be found at NetBeans website [4]. When working further with Forte™ and NetBeans, reason came up to question the choice of underlying IDE. Was Forte™ really the better of the two? To answer this question, a comparison between the tools had to be done. The differences between NetBeans and Forte™ are very small. Their GUI (Graphical User Interface) looks almost the same, so the user will not know on which IDE iWarf would be based. An interesting question was found at Forte’s FAQ website [1]:

“What's the difference between Forte for Java software and NetBeans software?"

"The NetBeans Tools Platform supports a large community of developers centered at netbeans.org. NetBeans software is primarily a platform for developers (including the Sun Forte Tools group), who want build to development tools. Each version of Forte for Java software is Sun's tested, supported, commercial implementation of the open standard NetBeans Tools Platform. The Forte for Java product also includes optional, ‘closed-source’ modules that are offered for a price."

The most interesting sentence from that answer is, *NetBeans software is primarily a platform for developers (including the Sun Forte Tools group), who want to build development tools* (grammatically corrected by author of this document). This is exactly what is to be done, so NetBeans might be a better choice. To make this decision on stronger grounds, more facts had to be found. When enough facts was found, they were listed as positive/negative attributes, which can be seen below.

Forte
+ Tested by Sun.
+ Support by Sun
+ CE (Community Edition) version is free but other versions are very expensive.
- Current version 2.0 does not include layers (easy creating menus and palettes, using XML) and wizards.
- Forte is based on NetBeans, and because of that, improvements will be made to NetBeans before they are put into Forte.

NetBeans
+ A platform for developers, who want to build development tools.
+ Core is updated more frequently as seen in Figure 2 below.
+ Absolutely free.
+ Current version 3.1 includes layers and wizards
+ The idea with NetBeans is to modify it to fit your needs.
+ Mailing lists (frequently used).
- No support.

This conclusion was made:
Building an Incomit service creation environment based directly on NetBeans seems like a much better idea because the purpose with NetBeans is to modify the environment to fit the user's needs. Forte is based on NetBeans and that means that iWarf indirectly will be based on NetBeans anyway. Below is a figure of a roadmap that shows that new versions of NetBeans are released more frequently than Forte™.
5 Description of the system design

The system design can be divided into graphical design and functional design. The graphical design is what the end user will use as an interface to communicate with the functional design. Another way of describing it: The graphical design is what is shown on screen. Behind the surface is the functional design. The functional design describes what action should be performed when a graphical object is activated.

5.1 Graphical User Interface design

The graphical user interface was built on the already existing IDE, NetBeans (version 3.2). This is what NetBeans GUI looks like:

![NetBeans GUI](image)

*Figure 3: NetBeans GUI*
5.1.1 Incomit menu
In the top menu bar a menu with the label, “Incomit” will be inserted (see Figure 4). This menu will include menu items in the following order:

- “Descriptor wizard”
- “Deploy to iSea”
- A line that separates the menu items (separator)
- “Incomit web”

![Figure 4: iWarf – Menu and palette](image)

5.1.2 Palettes
Two palettes, “iESPA” and “iUtils” (see Figure 4), will be inserted beside the already existing ones. These palettes consist of iSea services that can be dragged and dropped to the current project. The services will be displayed as an icon and a tool tip text. The services will be explained in chapter 5.2.2.

The iUtils will include the following services:

- “Db”
- “Log”
- “Trace”

The iESPA will include:

- “ECall”
- “Positioning”
- “Messaging”

5.1.3 Templates
The specific Incomit templates will show up when creating a new project file by choosing “File->New”. All templates will be placed in a sub directory called “Incomit”.

The following templates will be available:

- “iSea SLEE Client”
• “iSea SLEE Service”
• “iSea non-SLEE Client”
• “iSea non-SLEE Service”

5.1.4 Other graphical design parts
Below follows other graphical design parts.

• The text in the title bar of the IDE will be changed to “Incomit iWarf [version]”.
• The start up screen will be changed to the Incomit iWarf picture seen below.

![iWarf splash screen](image)

*Figure 5: iWarf splash screen*

5.2 Functional design
Each graphical object represents an underlying functional task. Those functional tasks are explained in this chapter.

5.2.1 Incomit menu

• “Descriptor wizard”
  When creating an iSea service, a descriptor file is needed. This file, *srv_depl.xml* contains attributes of the service and is needed by the SLEE. Since these are SLEE specific attributes, and not directly part of the iWarf prototype, they will be briefly described in Appendix C. A wizard is needed to make it easy for the user to write this file. By filling out fields, the user will go through this wizard with four steps (also see chapter 7.5).
• “Deploy to iSea”
  This will start up the Incomit Deployment tool that lets the user install a service (a JAR-file) into iSea. A slightly adjustment will be made to the tool, so it will fit better into iWarf.

• “Incomit web”
  When activated the Ice browser shows the Incomit website online. The Ice browser is a web browser integrated in NetBeans.

5.2.2 Palettes

• “Db”, ”Log”, ”Trace”, “Messaging” and “Positioning”
  These will not be fully implemented. The main reason for this is that they are very similar to ECall (ESPA call control). So more effort will be put in making that service well implemented and documented. Another reason is that the ESPA and the Utils API’s, which are used by all ESPA and Utils services, are not yet implemented.

• ECall
  The ECall API is defined, and that is what will be used to write a dummy class. The ECall dummy class will only do printouts as seen in Appendix B.2. For example the createCall(String number), will make the printout, “createCall: [the number string]”. When an ECall object is dropped onto the form, two lines of code will be generated:

  1. eCall1 = new com.incomit.espa.call.ECall();

  2. private com.incomit.espa.call.ECall eCall1;
6 Implementation – NetBeans development

This chapter illustrates how a developer can add extra features to the NetBeans IDE. The information below is based on NetBeans 3.2 and might change in later releases. Some of the features from chapter 5 were too complicated to explain in this chapter, therefore some features were replaced by more trivial examples.

6.1 NetBeans architecture

NetBeans is an open source, modular, standard-based IDE, totally written in Java™. It is based on different modules and this makes it really easy to modify to suit your needs. To add features to the IDE, creation of modules can be done (see chapter 6.2). To simplify the modification of the IDE, it is based on a virtual file system, in which files can be added just by writing some XML.

6.2 Modules

It is possible to create every feature directly within the NetBeans IDE, but this is not the right way of working if the features would be distributed to someone else. To do the later, a module that contains the features has to be created. There are no restrictions of how many features that can be added to one module, so there is no need for more than one module when customizing the IDE. The module will be packed into a JAR-file, called mymodule.jar, and then inserted into NetBeans.

6.2.1 The manifest file

The first thing to do when creating a module is to write a manifest file. This simple text file specifies the version and name of the module and the path to the layer file (see chapter 6.2.2). There are no restrictions to the manifest filename but the manifest file will be named Manifest.mf and placed in the folder [JAR-file root]/meta-inf/ when packing the JAR (see chapter 6.2.3). Below is an example of how a module manifest might look like.

1. Manifest-Version: 1.0
2. OpenIDE-Module: com.incomit.iwarf.modules
3. OpenIDE-Module-Name: Incomit iWarf module
4. OpenIDE-Module-Specification-Version: 0.1  
5. OpenIDE-Module-Implementation-Version: (xmagu/xgosk build 0001)  
6. OpenIDE-Module-Layer: com/incomit/iwarf/modules/Layer.xml  
7. Created-By: Incomit iWarf crew

<table>
<thead>
<tr>
<th>Line</th>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Manifest-Version</td>
<td>Should always be 1.0.</td>
</tr>
<tr>
<td>2.</td>
<td>OpenIDE-Module</td>
<td>Specifies the path (within the JAR-file) to the directory that contains the layer file and all other files in the module. Separate directories with dots.</td>
</tr>
<tr>
<td>3.</td>
<td>OpenIDE-Module-Name</td>
<td>This is the name of the module and will appear in Tools&gt;Options in NetBeans.</td>
</tr>
<tr>
<td>5.</td>
<td>OpenIDE-Module-Implementation-Version</td>
<td>The current implementation version of the module. Here the current build of the module can be specified.</td>
</tr>
<tr>
<td>7.</td>
<td>Created-By</td>
<td>User or company that has created this module.</td>
</tr>
</tbody>
</table>

### 6.2.2 Layer file

The layer file is the heart of the module. It contains a lot of information describing features that will be inserted into the IDE. With the layer file, a lot of code writing will not be necessary, instead a few lines of XML will be enough. The layer filename is often set to Layer.xml, but has actually no restrictions. Below is an example of a simple layer file that creates a new empty menu and places it between the Window and Help menus in NetBeans, as seen in Figure 6.

```xml
1. <filesystem>
2.     <folder name="Menu">
3.         <attr name="Window/MySubFolder" boolvalue="true"/>
4.         <folder name="MySubFolder">
5.         </folder>
6.         <attr name="MySubFolder/Help" boolvalue="true"/>
7.     </folder>
8. </filesystem>
```
<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The filesystem tag should always be put on the first line of the layer file.</td>
</tr>
<tr>
<td>2.</td>
<td>Specifies the virtual folder changes are made to, in this case the Menu (the menu bar).</td>
</tr>
<tr>
<td>3.</td>
<td>Forces NetBeans to place the MySubFolder menu after the Window menu.</td>
</tr>
<tr>
<td>5.</td>
<td>Ends the folder tag specified in line 4.</td>
</tr>
<tr>
<td>6.</td>
<td>Forces NetBeans to place the MySubFolder menu before the Help menu.</td>
</tr>
<tr>
<td>7.</td>
<td>Ends the folder tag specified in line 2.</td>
</tr>
<tr>
<td>8.</td>
<td>Ends the filesystem tag specified in line 1. Always at the last line in the layer file.</td>
</tr>
</tbody>
</table>

**Figure 6: Result from the layer file**

### 6.2.3 Installation

First the directories, specified in the manifest file, has to be created. In this case something like this (note that the Netbeans directory in the figure below has nothing to do with the NetBeans installation directory where the program files are stored):

**Figure 7: Setting up module directories**

Put the manifest file created in chapter 6.2.1 into the manifests directory and name it module-mf.txt. Then save the layer file, from chapter 6.2.2, as Layer.xml into the code\com\incomit\modules directory. Now enter the code directory and type the following to pack the JAR-file:

```
jar cvfm0 mymodule.jar ../manifests/module-mf.txt com/incomit/iwarf/modules
```
Then simply move the mymodule.jar file into the [NetBeans installation directory]\modules directory and start NetBeans. The changes will now be applied automatically. This makes it really easy to distribute the changes to someone else, by just copying the file. In later chapters, nothing is said about recompiling the JAR-file, when a new feature will be added. That is taken for granted.

6.3 Templates

This chapter describes how to create a template and then put it into the module created in the previous chapter. Templates can be created with or without group files. When using a group file one or more files can be added to the template, without a group file only one single file can be added. Because it is a lot easier to add another file to a template based on a group file, non-group file based templates will not be discussed here. The following example is the iSea SLEE Client template described in chapter 7.2.

6.3.1 Template files

Start with creating some new directories to store the template files in (see figure below).

![Figure 8: Setting up template directories](image)

These directories are not necessary but this is done for making it look nice and easy. Then three files are needed in the iSeaClient directory to be able to create the template.

**iSeaClient.java**

This file includes the code that is going to be static when creating an iSea SLEE Client. Macros can be used in this file to get the current date and time, the Microsoft Windows username and the filename. The source can be found in Appendix B.1. Since this file is not going to be compiled call it iSeaClient.java (this will not mix it up with .java files). To be able to compile the Java™ source file that is generated from this file in NetBeans,
installation of the com.incomit.slee class library is required. How to install external class libraries is explained in chapter 6.3.5.

**iSeaClient_form**

This file is used for getting a form in the NetBeans IDE that enables components to be added by dragging ‘n’ dropping. This file will always have the appearance as described below:

1. `<xml version="1.0" encoding="UTF-8" ?>`
2. `<Form version="1.0">
3.   type="org.netbeans.modules.form.forminfo.FrameFormInfo">
4.   </Form>`

**iSeaClient_group**

The last file is the group file that contains the path to all files that are to be included in the template. The path is the one found in the layer file as virtual folders (see chapter 6.3.2 for further details). The files that will be included are the two files above. This is how the file looks like:

1. Templates/Incomit/SLEE/__NAME_sleeClient__.java
2. Templates/Incomit/SLEE/__NAME_sleeClient__.form

### 6.3.2 Layer file – create the template

Now some text has to be inserted into the layer file to really create the template in NetBeans. Put this in the `Layer.xml` below the `<filesystem>` tag (see chapter 6.2.2):

1. `<folder name="Templates">
2.   <folder name="Incomit">
3.     <attr name="templateWizardURL" urlvalue="nbresloc:/com/incomit/iwarf/modules/templates/resources/incomit.html"/>
4.     <folder name="SLEE">
5.       <attr name="templateWizardURL" urlvalue="nbresloc:/com/incomit/iwarf/modules/templates/resources/slee.html"/>
6.       <file name="iSeaClient.group" url="templates/slee/iSeaClient/iSeaClient_group">
7.         <attr name="template" boolvalue="true" />
8.   </folder>
9. </folder>
10. </folder>`
8. <attr name="SystemFileSystem.localizingBundle" stringvalue="com.incomit.iwarf.modules.templates.Bundle" />
9. <attr name="templateWizardURL" urlvalue="nbresloc:/com/incomit/iwarf/modules/templates/resources/iSC.html"/>
10. <attr name="SystemFileSystem.icon" urlvalue="nbresloc:/com/incomit/iwarf/modules/templates/resources/iSC.gif" />
11. </file>
12. <file name="__NAME_sleeClient__.java" url="templates/slee/iSeaClient/iSeaClient_java">
13.      <attr name="template" boolvalue="false" />
14.   </file>
15. <file name="__NAME_sleeClient__.form" url="templates/slee/iSeaClient/iSeaClient_form">
16.      <attr name="template" boolvalue="false"/>
17.   </file>
18.   </folder>
19.     </folder>
20. </folder>

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Specifies the virtual folder in where to make the change, in this case Templates. This is the first entry in the group file path (see the iSeaClient_group file in chapter 6.3.1).</td>
</tr>
<tr>
<td>2.</td>
<td>Creates a new folder named Incomit. This is the second entry in the group file path (see the iSeaClient_group file in chapter 6.3.1).</td>
</tr>
<tr>
<td>3, 5, 9.</td>
<td>Sets the paths to the help files displayed when selecting the Incomit directory (3), SLEE directory (5) or the iSeaClient template (9). See chapter 6.3.3.</td>
</tr>
<tr>
<td>4.</td>
<td>Creates a new folder named SLEE. This is the third entry in the group file path (see the iSeaClient_group file in chapter 6.3.1).</td>
</tr>
<tr>
<td>6-11.</td>
<td>Adds the group file to the template. Use dot instead of underscore in the name so that NetBeans associates right. URL is relative to the layer file.</td>
</tr>
<tr>
<td>7.</td>
<td>Tells NetBeans that this file is a template.</td>
</tr>
<tr>
<td>8.</td>
<td>Path to the bundle file (Bundle.properties). See chapter 6.3.4.</td>
</tr>
<tr>
<td>10.</td>
<td>The icon displayed in NetBeans. See chapter 6.3.3.</td>
</tr>
<tr>
<td>12-14.</td>
<td>Adds the Java™ file to the template. Use dot instead of underscore in the name.</td>
</tr>
</tbody>
</table>
6.3.3 Resource files
Resource files are html files and gif files that represent help files and icons that appear at different places. Icons have the size of 16x16 pixels and can have transparent background. The help files consist of common html code.

Create the help files incomit.html, s1ee.html, iSC.html and the icon iSC.gif and put them into the resource directory to get the template work properly.

6.3.4 Bundle file
Bundle files are very common in the NetBeans IDE. They provide an easy way of changing names, paths or whatever that can be written in text. This makes it easier to change a path without changing the code. Just change the text in the bundle, re-pack the JAR and the changes are done.

The bundle has the filename Bundle.properties but the path to it, in the layer file, is in this case com.incomit.iwarf.modules.templates.Bundle, without the .properties. Create a Bundle.properties, put it in the templates directory and insert the following text:

1. Templates/Incomit/SLEE/iSeaClient.group=iSea SLEE Client

The path above is based on the virtual folders and file, created in the layer file (see chapter 6.3.2). iSea SLEE Client is the name that will appear in NetBeans, when selecting the template.

6.3.5 Adding external libraries to NetBeans
If there exists an xwing.class in the class library starwars.jar, and the xwing class is needed by the Star Wars GUI you are currently working on, then the starwars.jar needs to be added to the NetBeans class library. To achieve this, start by copying starwars.jar into the [NetBeans installation directory]\lib\ext directory. After that add the code
below to the layer file. If the starwars.jar class library is not added to the NetBeans class library, a class not found error would occur during compilation.

1. `<folder name="Mount">
2.   `<folder name="java">
3.     `<file name="starwars.xml">
4.        `<![CDATA[
5.          <!DOCTYPE JavaLibrary PUBLIC "-//NetBeans IDE//DTD JavaLibrary//EN" http://www.netbeans.org/dtds/JavaLibrary-1_0.dtd">
6.          `<Library>
7.            `<Archive name="lib/ext/starwars.jar"/>
8.          </Library>
9.        `]]>
10.   `</file>
11.  `</folder>
12. `</folder>

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Specifies the virtual folder in where to make changes, in this case Mount.</td>
</tr>
<tr>
<td>2.</td>
<td>The virtual folder for Java™ classes.</td>
</tr>
<tr>
<td>3.</td>
<td>Here a virtual XML file that includes data about the library is created. Choose a filename, but it is a good idea to have the same name on the XML as on the JAR.</td>
</tr>
<tr>
<td>4.</td>
<td>Here is the start of the data in the virtual XML file.</td>
</tr>
<tr>
<td>5.</td>
<td>Always begin the data with this line.</td>
</tr>
<tr>
<td>6-8.</td>
<td>Here is the library added to the NetBeans class library. The archive path is relative to the NetBeans installation directory.</td>
</tr>
<tr>
<td>9.</td>
<td>Ends data.</td>
</tr>
</tbody>
</table>

### 6.4 Palette – create the drag ‘n’ drop feature

This chapter describes how to create a palette tab and put a JavaBean component, ECall, into it that can be dragged ‘n’ dropped into a form window (see chapter 7.3).
6.4.1 Layer file – create the palette
To create the palette a few lines have to be added to the layer file in the module. Just add the following lines after the <filesystem> tag (see chapter 6.2.2).

1. <folder name="Palette">
2.   <folder name="iESPA">
3.     <file name="com-incomit-espa-call-ECall.instance"/>
4.   </folder>
5. </folder>

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Specifies the virtual folder in where to make changes, in this case Palette.</td>
</tr>
<tr>
<td>2.</td>
<td>Creates a new folder named iESPA.</td>
</tr>
<tr>
<td>3.</td>
<td>Creates an instance of the component class ECall in the package com.incomit.espa.call. This is the component that can be dragged 'n' dropped into the form. See chapter 6.4.3 for further details.</td>
</tr>
</tbody>
</table>

6.4.2 The manifest file – specifying the palette component
A new manifest file has to be written for the components. This is because of the need for a new JAR-file to put the component(s) in. The component class file should not be included into the module but instead as an external library (see chapter 6.3.5). Name it palette-mf.txt and put it in the manifests directory. It looks like this:

1. Manifest-Version: 1.0
2. Created-By: Incomit iWarf crew
3. Name: com/incomit/espa/call/ECall.class
4. Java-Bean: True

6.4.3 The component
Now the component, that was mentioned in chapter 6.4.1, has to be created. The component consists of a common JavaBean class and a bean info class. The bean info class consists of information about the common class, like properties and methods but also the path to the icon shown in the palette. The easiest way to do this is to use NetBeans to create the bean info class, but first the common class.
**JavaBean class**

First the two new directories introduced in line 3 in chapter 6.4.1, have to be created. The `com\incomit` already exists so only the `espa` and the `call` directories have to be created. A `resources` directory can also be added, for help files and icons.

![Figure 9: Setting up component directories](image)

Now the JavaBean class (`ECall.java`) has to be created and put in the `call` directory. It is a common class that only does printouts. The source can be found in Appendix B.2.

**Bean info class**

Now create the bean info class in NetBeans. Start by making a 16x16 pixels icon (gif-file) and put it in the `resources` directory. This icon will later be seen in the palette. Then open the `ECall.java` file in NetBeans by selecting File->Open File… Browse to the `Ecall.java` file and hit the accept button. The file will now be mounted in the Explorer view. Expand all directories if necessary until you can access Bean Patterns seen in Figure 10.

![Figure 10: Explorer view](image)
Now right-click Bean Patterns and choose BeanInfo Editor… (see Figure 11).

![BeanInfo Editor](image)

**Figure 11: BeanInfo editor**

Then click the BeanInfo and browse for the Icon 16x16 Color. Select Classpath and browse for the gif file. Hit ok a few times. Now the ECallBeanInfo source appears in NetBeans. Save the file and exit NetBeans.

### 6.4.4 Final installation

Enter the code directory, compile the .java files and pack the JAR-file like this:

```bash
javac -deprecation -g com/incomit/espa/call/*.java
jar cvfm0 incomitbeans.jar ../manifests/palette-mf.txt com/incomit/espa
```

Move the JAR-file into the [NetBeans installation directory]\lib\ext directory. Now the library (JAR-file) has to be added into NetBeans, exactly as in chapter 6.3.5. Add the following in the Mount/java folders in the layer file.

1. `<file name="incomitbeans.xml">
2.   <! [CDATA[
3.     <!DOCTYPE JavaLibrary PUBLIC "-//NetBeans IDE//DTD JavaLibrary//EN" "http://www.netbeans.org/dtds/JavaLibrary-1_0.dtd">
4.     <Library>
5.       <Archive name="lib/ext/incomitbeans.jar"/>
6.     </Library>
7.   ]]>
Now the ECall component can be dragged 'n' dropped into the form window.

6.5 Wizards

This chapter describes how to create a simple wizard in NetBeans. Wizards can be used for making difficult tasks easier for the user. In NetBeans there exist some help classes for building wizards that makes it a little easier. In this tutorial the two-step Hello World wizard seen below, will be created.

![Image of the Hello World Wizard](image)

*Figure 12: The complete step 1 in the wizard*

6.5.1 Wizard files

Start by creating a wizards directory in the modules directory. In that directory create the two directories helloworld and resources (see Figure 13).
A wizard consists of a main class and one panel class for each step, in this case two. Each panel class extends JPanel on which swing components or common awt components can be added. It also implements an interface to handle common wizard features. The main class manages the panels and all communication is controlled from this class.

**HelloWorldPanel1.java**

Figure 12 illustrates the first step that will appear to the user. HelloWorldPanel1.java is the panel seen in Figure 14. In this step the user has to enter a secret password in the text field. When this is done, the next button (see Figure 12) will be enabled.

Create the first panel by saving the file HelloWorldPanel1.java (see Appendix B.3) in the helloworld directory.
**HelloWorldPanel2.java**

This is the second step that will appear when the user has entered the correct password and hit next in the first step. This panel contains a label with the text, “Congratulations!!! You have entered the secret password!!!”. In this step the user can either go back or click Finish to close the wizard. This class is much simpler than the HelloWorldPanel1 class. For example there are no listener or event handlers. Put the source in the file HelloWorldPanel2.java (see Appendix B.4) in the helloworld directory.

![Figure 15: Complete step 2 in the wizard](image)

**HelloWorld.java**

This is the main class where communication with the panels can be handled. For example, buttons can be set enable or disable, texts in the wizard can be set and much more. The class includes a WizardDescriptor class that is a basic wizard GUI system. The panels will then be added to the WizardDescriptor. Simply put the source in the file HelloWorld.java (see Appendix B.5) in the helloworld directory.
**helloworld_panel1.html**
This is the file specified in the help file URL in the HelloWorldPanel1 class. Put it in the resources directory.

1.  <HTML>
2.   <BODY>
3.     <CENTER>Try typing 'hello world' in the textfield.</CENTER>
4.   </BODY>
5.  </HTML>

**helloworld_panel2.html**
This is the file specified in the help file URL in the HelloWorldPanel2 class. Put it in the resources directory.

1.  <HTML>
2.   <BODY>
3.     <CENTER>Click finish to exit.</CENTER>
4.   </BODY>
5.  </HTML>

Now the Java™ files have to be compiled. Add all files to the JAR-file and it is done. To be able to start this wizard from a menu, an action has to be created. This will be done in chapter 6.6.1.

### 6.6 Menus and actions

This chapter describes how to create menus and actions. Menus make it easy for the user to reach specific tasks. An action is called when the user clicks on a menu item in a menu. Create a menus directory in modules and incomit and resources in the menus directory (see Figure 16).
6.6.1 Actions

There are different types of actions where the CallableSystemAction is the most suitable for menu actions. To be able to start the wizard, created in chapter 6.5, from a menu item, an action class is needed.

**HelloWorldWizardAction.java**

This is the action class for the wizard. Its three main purposes are:

- Fetch the menu name associated with the wizard.
- Fetch the icon associated with the wizard.
- Instanciate the HelloWorld class.

Put the HelloWorldWizardAction.java (see Appendix B.6) file in the incomit directory.

**Bundle.properties**

In the bundle file the name of the menu item can be specified. The & sign in row 2 below means that the letter after it will be underscored in the menu. Hello World Wizard is the name of the menu item. Save this file in the incomit directory.

1. # MenuActions
2. LBL_HelloWorldWizardAction=&Hello World Wizard

6.6.2 Menus

To a menu, either action classes or URLs can be added. To finally be able to start the wizard from the menu a few things have to be done.
The layer file – create the menu

As was done in chapter 6.2.2, a few lines have to be added to the layer file to create a menu. Add the lines below to the layer file. Put it after `<folder name="Menu">` (see chapter 6.2.2).

```
1. <attr name="Tools/Incomit" boolvalue="true"/>
2. <folder name="Incomit">
3.   <attr name="SystemFileSystem.localizingBundle" stringvalue="com.incomit.iwarf.modules.menus.incomit.Bundle"/>
4.   <file name="com-incomit-iwarf-modules-menus-incomit-HelloWorldWizardAction.instance"/>
5. </folder>
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Puts the Incomit directory after the Tools menu.</td>
</tr>
<tr>
<td>2.</td>
<td>Creates the Incomit menu.</td>
</tr>
<tr>
<td>3.</td>
<td>Specifies the path to the bundle file, in this case used for specifying which letter to underscore in the menu name.</td>
</tr>
<tr>
<td>4.</td>
<td>Path to the action class created in chapter 6.6.1. Put .instance at the end of the path instead of .class.</td>
</tr>
</tbody>
</table>

**Bundle.properties**

To specify which letter to underscore, a line has to be added into the bundle file. Add the following lines to the bundle file in the incomit directory where line 2 specifies that the I letter will be underscored.

```
1. # Menu keys
2. Menu/Incomit=&Incomit
```

**Creating an URL in a menu**

Start by adding the following lines after the `<file name="com-incomit-iwarf-modules-menus-incomit-HelloWorldWizardAction.instance"/>` attribute in the layer file.

```
1. <file name="incomit-web-link.url">
2.   <![CDATA[http://www.incomit.com/]]>
3.   <attr name="SystemFileSystem.localizingBundle" stringvalue="com.incomit.iwarf.modules.menus.incomit.Bundle"/>
```
4.  <attr name="SystemFileSystem.icon" urlvalue="nbresloc:/com/incomit/iwarf/modules/menus/resources/weblink.gif"/>
5.  </file>

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The filename of the virtual URL file.</td>
</tr>
<tr>
<td>2.</td>
<td>Enter the URL inside the [].</td>
</tr>
<tr>
<td>3.</td>
<td>Specifies the path to the bundle file, in this case used for specifying which letter to underscore in the menu item name.</td>
</tr>
<tr>
<td>4.</td>
<td>Path to the 16x16 icon that will appear in the menu.</td>
</tr>
</tbody>
</table>

Then add the following to the bundle file (Bundle.properties) in the incomit directory.

1.  Menu/Incomit/incomit-web-link.url=Incomit &Web

This will make the W letter underscored.

**Creating a separator in a menu**

Just add the following line after `<file name="com-incomit-iwarf-modules-menus-incomit-HelloWorldWizardAction.instance"/>` in the layer file.

1.  `<file name="Sep1[javax-swing-JSeparator].instance"/>`

If multiple separators are wanted in the same menu, name them Sep1, Sep2, ...

**Ordering menu items**

If the following order is wanted of the menu items in the menu: wizard menu item, the separator and last, the URL. Then add the following two lines to the layer file after the separator tag above.

1.  `<attr name="com-incomit-iwarf-modules-menus-incomit-HelloWorldWizardAction.instance/Sep1[javax-swing-JSeparator].instance" boolvalue="true"/>
2.  `<attr name="Sep1[javax-swing-JSeparator].instance/incomit-web-link.url " boolvalue="true"/>
6.7 Filesystem example

Instead of accessing files through pure Java™ API’s, NetBeans offers the package org.openide.filesystems, where the FileSystem and the Repository classes can be accessed. The Repository is a singleton class that corresponds to the Explorer window in NetBeans. The Repository consists of all mounted filesystems. The NetBeans crew describes the Filesystems API as follows [2]:

“The FileSystems API permits module authors to access files in a uniform manner: e.g. you may be unaware of whether a file you are using is stored on local disk in the user's repository, or stored in an auxiliary directory, or stored in a JAR archive. Alternately, you may have reason to implement a custom file system--e.g. a vendor tool being integrated into the IDE may have its own local or remote storage of files in a special fashion; using this API, the rest of the IDE will be able to seamlessly view your files.”

6.7.1 Simple example

Consider the following. A local file, c:\myfolder\myfile.txt, should be mounted so it will be accessible in the Explorer window in the NetBeans IDE. This is a quite simple task to perform. If the folder, c:\myfolder does not exist, it will be created. If the file, myfile.txt does not exist, it will be created. First the following directory structure has to be created:
Layer.xml

The Layer.xml file is used to add the menu item into the Incomit folder. Add the following line, to the virtual folder Menu -> Incomit in the layer file.

1. `<file name="com-incomit-modules-menus-incomit-FileExampleAction.instance"/>

Bundle.properties

The bundle file is called from the FileExampleAction class. It is used to name the menu item “File Example”. Add this line to the bundle file in the filesystem directory:

1. LBL_FileExampleAction=&File Example

Example.java

This class mounts `c:\myfolder\myfile.txt` to the NetBeans Explorer window. Put Example.java (see source in Appendix B.7) in the directory fileapiexample.

FileExampleAction.java

This file extends CallableSystemAction and its main purpose is to start the Example class. It also holds a function to fetch its name from the bundle file. This is the name that will be visible for the user in the Incomit menu. Put the file (see source in Appendix B.8) in the directory incomit. Create the 16x16 pixels icon, FileExampleAction.gif, and put it in the resource directory.
Compile the files using:

javac -deprecation -g
c:/netbeans/lib/openide.org;c:/netbeans/lib/openide-util.org;c:/netbeans/lib/openide-fs.org
com/incomit/iwarf/modules/fileapiexample/*.java
com/incomit/iwarf/modules/menus/incomit/*.java

6.8 Other

This chapter will explain how to change the start-up logotype and the window title, and how to enable code completion.

6.8.1 Changing the start-up logotype

To change the start-up logotype, create a c:\core\jar temp directory and unpack the [NetBeans installation directory]\lib\core.jar (easiest with WinZip) into that directory. Copy the \meta-inf\Manifest.mf to the core directory. Open, edit and save the logotype file c:\core\jar\org\netbeans\core\resources\splash.gif. Then pack the JAR by entering the jar directory and enter the command jar cfm0 core.jar ../Manifest.mf *. Move the new core.jar file into the c:\netbeans\lib and overwrite the existing file.

6.8.2 Changing the coordinates of the text in the start-up logotype

To alter the loading text coordinates in the splash screen, assuming that the core.jar is unpacked as in chapter 6.8.1, open the bundle property file c:\core\jar\org\netbeans\core\Bundle.properties and change the SplashRunningTextBounds attribute. The numbers are x-coordinate, y-coordinate, width and height separated by comma. Save the file and pack the JAR-file like in chapter 6.8.1.

6.8.3 Changing the window title.

To set the NetBeans window title, edit the very same Bundle.properties as in chapter 6.8.2. Change the currentVersion attribute to whatever is preferred. The bundle property file c:\core\jar\org\netbeans\core\windows\Bundle.properties also has to be edited. Here change the CTL_MainWindow_Title and CTL_MainWindow_Title_Project to whatever is preferred. Save the files and pack the JAR as in chapter 6.8.1.
6.8.4 Add code to the parser database (code completion)

To enable code completion for objects, install the JAR file containing the objects into NetBeans as was done in chapter 6.3.5. Then start NetBeans and choose File->Mount Filesystem and choose to add the JAR file. Hit Ok to mount it. Right-click the mounted JAR file in the Explorer window and choose Tools->Update Parser Database… Choose a name and select which classes/fields/methods to include in the database and hit Ok. Two new files will be created in the c:\netbeans\system\ParserDB or the [NetBeans installation directory]\myuserfiles\system\ParserDB with the filename decided and the extensions .jcb and .jcs. These files can be moved between different installations of NetBeans if put in the [NetBeans installation directory]\system\ParserDB directory.
7 Use case – Create and deploy iSea SLEE Client

Not much testing has been done in this Bachelor’s project, partly because iWarf is a prototype, but also because there are no good ways of testing it. Instead a use case will be described in this chapter. When going through this case, all features added to NetBeans will be used. This chapter describes how to create a simple iSea client with the iWarf tool.

7.1 Environment

For this prototype, only an iSea SLEE Client can be created. The example client will create a conference call with three participants using the ESPA ECall. At this point the ESPA ECall exists only as an API, so a dummy class was made, that only does printouts. The creation of an iSea SLEE Client starts with choosing a template. Thereafter items from the palette can be dropped to the project. Then the user must write some trivial code. When the client is complete the user will create a descriptor XML file, needed by the SLEE. The client files will be packed in a JAR-file, using the NetBeans JAR packager. Finally the JAR-file will be deployed into iSea using the integrated Incomit deployment tool.

7.2 Templates

First choose to create a new project file (ctrl + n). Browse to the iSea SLEE Client template (see Figure 18) and then continue by clicking next.

![Figure 18: Choosing the template](image)

The next step is to name the project and to determine which package it will belong to. For this example choose to name the project MyTestClient and place it in the package com.incomit.testing (see Figure 19 and Figure 20).

![Figure 19: Project name](image)
When done choosing the template, press finish to complete this wizard. This will make NetBeans think for a few seconds, so just stand by for a while. Now the two windows, Form [MyTestClient] and Source Editor [MyTestClient] will pop up. The Source editor now contains prewritten code that matches the selected template, in this case the iSea SLEE Client.

### 7.3 Palettes

The form window is needed to drop palette components into. Choose to drop an ESPA ECall to the project. Do this by clicking once on the palette component (see Figure 21) and then click anywhere in the form window.

Two lines of code will be generated in MyTestClient.java, a declaration line and an initialisation line. The name of the object will be [classname] followed by an incrementing number, in this case, eCall1.

### 7.4 Coding

The created object can be seen in the component inspector (see Figure 22). With the component inspector many nice features can be accessed, such as renaming the object and setting properties of the object.
Now it is time to create the conference call. To make it easier for the user, the ECall class library has been added to NetBeans parser database (see chapter 6.8.4). This enables code completion as seen in the figure below.

To create the call, write the following code:

1. `eCall1.createCall("0701234567");`
2. `eCall1.addParticipant("0707894561");`
3. `eCall1.addParticipant("0701223344");`
4. `eCall1.endCall();`
In this example put line 1 in the method `started()`, line 2 and 3 in the method `activated()` and line 4 in the method `deactivated()`. Save and compile the file by hitting F9.

### 7.5 Descriptor Wizard

To be able to deploy this client to iSea, the descriptor file, `srv_depl.xml`, is needed. This file contains information about the client, and is needed by the SLEE. If this file is missing or is incorrect the client will not be accepted by the SLEE. In the Incomit menu, there is a Descriptor wizard that can be used to create the descriptor file in four easy steps (see Appendix C):

- **Basic service definition**
  In the first step the only required field to fill in is Name. This is the name the client will have in the SLEE. Set the name to “MyClient”. The other fields are optional, and can be left out without change.

- **Service classes definition**
  In this step there is one required field, Deployable. Since there is only one file in the project, `MyTestClient.java`, and this file implements the Deployable interface, fill in the deployable field like this: `com.incomit.testing.MyTestClient`. The remaining fields cannot be filled in, since there are no classes implementing any of the mentioned interfaces.

- **Choose descriptor path**
  Now that all required fields are filled out, specify where to save the descriptor file. Select the directory, either writing it by hand or browse for the directory of your desire. Later on the descriptor file will be placed into the root of a JAR-file as well as the client package, so it might be a good idea to save it with this structure at this stage already (see Figure 24).

![Figure 24: File structure](image)

- **Manual edit**

38
This step gives the opportunity to quickly view and change the content of the descriptor file. If it looks ok, press finish to create the srv_depl.xml. Shortly after, the srv_depl.xml will appear in the Explorer window, as shown in the figure above.

### 7.6 JAR-packaging

NetBeans has a built-in JAR-packager. The usage of this packager needs to be discussed a bit, because it might be a bit confusion of how it works. Create a JAR contents object from a template (see Figure 25).

![Figure 25: JAR contents](image)

In the next step enter a name for the JAR contents, and where to place it. Name the JAR contents myjarcontents. This object is not a JAR-file, but merely an object that describes the JAR-file. To create the JAR-file, specify which files that should be included in the JAR-file (see Figure 26) and then compile the JAR contents. The output of this compilation is the JAR-file. Press next to add files to the JAR contents.

![Figure 26: Adding files and directories to the JAR contents file](image)
Press next to choose the JAR-file location. The final step is to write the manifest file, which is optional. Press finish to complete the wizard.

Locate myjarcontents in the Explorer window and right-click on it. If additional properties need to be set, choose properties in the popup menu (see Figure 27). When satisfied press compile in the popup menu to create a JAR-file from myjarcontents.

![Figure 27: JAR contents properties](image)

### 7.7 Deploy to iSea

Access to iSea is needed to complete this step. To deploy the created JAR-file, choose Deploy to iSea in the Incomit menu. The window that pops up is the standard Incomit deployment tool, just slightly adjusted to fit into iWarf. How the deployment tool, iSea and iWarf communicate is illustrated in Figure 28. Since the deployment tool is under development and the authors of this document is not engaged with that project, details about its usage will not be given. The ECall class will do printouts on the iSea machine.

When starting it, `createCall: 0701234567` is printed on the screen.

When activated, `addParticipant: 0707894651 [newline] addParticipant: 0701223344` is printed.

When deactivated, `endCall` is printed.

An iSea service has step by step successfully been created using the extra features added to NetBeans.
Figure 28: How iWarp and iSea are related
8 Problems and experiences

Since this Bachelor’s project was about making a prototype, focus was intentionally on finding a way to achieve as many goals as possible, without adding features not included in the requirements specification. Even though code completion was not listed as a requirement, it was a simple, but powerful feature to include.

8.1 Problems

Along the way some problems of different character were encountered. The problems can be divided into NetBeans related, implementation and Incomit related problems.

8.1.1 NetBeans related problems

NetBeans is an IDE in change. At first NetBeans 3.1 was used as foundation. When writing the descriptor wizard, problems occurred. The wizard GUI did not work properly. After some research on the NetBeans website, we came to the conclusion that the fault was embedded in NetBeans. The only solution to this problem was to update NetBeans. An early 3.2 beta release was installed. When trying to install the iWarf module to this version of NetBeans, a lot of exceptions were thrown when starting up the IDE. For some reason (probably a good one) the NetBeans class library files had been split into several smaller files. There were also changes made to the form editor, so adjustments to the code had to be done. The JAR packager was changed too. In NetBeans 3.1 it was located in the tools menu, but was now a template! Upgrading to the 3.2 beta required several days of work. When the wizard was completed, we discovered that the JAR packager in this release was not working properly. This forced another upgrade. This upgrade went smoother, but some changes had been made to the form editor again! They probably were not happy with the last changes. For every new upgrade, changes in the iWarf module had to be done to fit in NetBeans.

8.1.2 Implementation problems

The making of the descriptor wizard was not easy. The first problem, described above, was caused by an old version of NetBeans. The wizard implements the org.openide.WizardDescriptor.Iterator interface, which was not easy to understand. There were also some problems concerning creating templates groups, in other words a
template containing more than one file. Through mailing lists and examples on NetBeans website, we finally got it to work.

8.1.3 Incomit related problems

As mentioned before in this document, the ESPA and Utils classes were not implemented. The solution to this problem has been to write a dummy class, ECall that was used for testing. Another problem that made it hard to test services, created in iWarf, is that Incomit temporarily lost the connection to the PSTN.

8.2 Experiences

Before we started designing iWarf we wrote a requirement specification document that was approved by Pär, our company supervisor. We tried to follow it from the start to the end, but some requirements where not achieved. The requirements R1 to R17 can be found in Appendix A. R1 and R2 are not functionally implemented due to lack of experience in CORBA (Common Object Request Broker Architecture). R3 actually has lower priority then R1 and R2, but R3 was easier to achieve. R8 – R12 is not fully implemented (see 8.1.3). R14 was split into two issues, creating XML descriptor file and packing the JAR file. The requirements R3-R7 and R13-R17 were fully implemented.

New experience was gained in XML, Java™ and GUI design but also in the design of telecom systems of tomorrow and what kind of telecom services that will be present in a near future. Since NetBeans was used as foundation of iWarf, we have learned the architecture of NetBeans and how to modify and use the IDE. Through mailing lists we have participated in discussions concerning development of the NetBeans IDE. Beside this we have learned how the modern IT company Incomit develops their products.

We wrote diaries every day, which was of great help when looking back to see what was done earlier. It also helped us to see working hours each day. When problems were solved, we wrote howto’s describing the problems, and how they were solved.
9 Conclusions

The purpose with this Bachelor’s project was to create a service creation environment that makes it easier to develop telecom and Internet services.

Our conclusion is that service creating has never been easier. The required programming skills for making iSea services using iWarf are far less than writing them in a common editor. To set up a call between two persons, only three lines of code need to be written manually. Actually, that is not completely true, because the code completion helps the user writing those three lines. This means that we have succeeded creating a user-friendly IDE for fast development of telecom and Internet services.

In the preliminary investigation a comparison between Forte™ and NetBeans was made. The choice of using NetBeans was obvious, but it is hard to tell what the result would have been with another IDE. NetBeans is quite easy to modify because it is based on open APIs and the help from the mailing lists is really good. The NetBeans IDE is really easy to use, but even on today's high-end computers NetBeans is a bit slow.

Incomit will develop the commercial version of iWarf this summer. It will be based upon knowledge received from our work with the prototype. What can be done to achieve a commercial product? The main thing to be done is to change all texts and picture to be more Incomit specific, so the customers will not see the NetBeans logo and texts. Then the Incomit specific features can be added, like the requirements R1-R3 and R5-R16. More wizards might be used to make difficult tasks simplified for the users. iWarf is a very modular IDE with open API's so there is no end to the possibilities.
## Terminology and abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CORBA</td>
<td>Common Object Request Broker Architecture.</td>
</tr>
<tr>
<td>ESPA</td>
<td>Incomit Easy SPA.</td>
</tr>
<tr>
<td>Forte™</td>
<td>IDE based on NetBeans, developed by Sun.</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface.</td>
</tr>
<tr>
<td>HTTP</td>
<td>Hyper Text Transfer Protocol (protocol for transferring files for the web).</td>
</tr>
<tr>
<td>IDE</td>
<td>Integrated Development Environment.</td>
</tr>
<tr>
<td>Incomit</td>
<td>An Internet- and telecom-company in Karlstad.</td>
</tr>
<tr>
<td>ISCE</td>
<td>Incomit Service Creation Environment.</td>
</tr>
<tr>
<td>iSea</td>
<td>Application server connected to Internet and iSluice.</td>
</tr>
<tr>
<td>iSluice</td>
<td>Connected to the telecom network and to one or several iSea servers.</td>
</tr>
<tr>
<td>JAIN</td>
<td>The JAIN program is organized by a number of Expert Groups for Java™ telecom APIs.</td>
</tr>
<tr>
<td>JAR</td>
<td>Java™ ARchive file format.</td>
</tr>
<tr>
<td>JavaBeans™</td>
<td>Java™ object that complies with the JavaBeans™ component architecture.</td>
</tr>
<tr>
<td>NetBeans</td>
<td>Open-source, modular IDE founded by Sun.</td>
</tr>
<tr>
<td>PDA</td>
<td>Personal Digital Assistant (a handheld computer).</td>
</tr>
<tr>
<td>PSTN</td>
<td>Public Switched Telephone Network.</td>
</tr>
<tr>
<td>SDS</td>
<td>System Design Specification.</td>
</tr>
<tr>
<td>servlet</td>
<td>Web server side Java™ application.</td>
</tr>
<tr>
<td>SLEE</td>
<td>Service Logic Execution Environment.</td>
</tr>
<tr>
<td>SPA</td>
<td>JAIN Service Provider API.</td>
</tr>
<tr>
<td>Sun</td>
<td>A worldwide company that among other things is the founder of the Java™ language.</td>
</tr>
<tr>
<td>Utils</td>
<td>Log, trace and database services implemented in iSea.</td>
</tr>
<tr>
<td>WAP</td>
<td>Wireless Application Protocol.</td>
</tr>
<tr>
<td>XML</td>
<td>eXtended Markup Language.</td>
</tr>
</tbody>
</table>
References

[2] NetBeans FileSystem API -
[2001-05-17]
[3] NetBeans HelpContext -
[5] SLEE API specification -
A Requirements specification

Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Editor</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA1</td>
<td>2001-02-09</td>
<td>MaGu, GoSk</td>
<td>First version.</td>
</tr>
<tr>
<td>PA2</td>
<td>2001-03-09</td>
<td>MaGu</td>
<td>Some updates</td>
</tr>
<tr>
<td>A</td>
<td>2001-05-04</td>
<td>MaGu, GoSk</td>
<td>Final</td>
</tr>
</tbody>
</table>

Abstract

This document contains the requirements for the Bachelor's project, which will be done at the company, Incomit. The Bachelor's project can be divided to following parts; investigation, service creation environment, iSea service, documentation and presentation.

Scope

The investigation will include:

- Investigate which development tool to use

The service creation environment will be modified to support these extra features:

- Incomit templates - easy way to create Incomit services
- Incomit palettes - easy way to add Incomit components by drag ‘n’ drop
- Incomit menus - for accessing special options, such as deploy
- Incomit GUI - an Incomit look-a-like environment
- Incomit Depl. tools - deploy service to iSea or file.

The iSea service:

- Create a service of our choice using the service creation environment

The presentation:

- Present the work for the Incomit crew
System creation environment advantages:

- Simple ness - easy way to create and deploy Incomit services
- Flexible - easy to modify

The main goal is to find an easy way to create Incomit services and report the result.

**Functional requirements for the service creation environment**

Warf-R1. **Create an Incomit service project**
Done by choosing a specific Incomit service template when a new project is created.
Prio: 1

Warf-R2. **Create a specific Incomit servlet project**
Done by choosing a specific Incomit servlet template when a new project is created.
Prio: 2

Warf-R3. **Create a specific Incomit client project**
Done by choosing a specific Incomit client template when a new project is created.
Prio: 3

Warf-R4. **Investigate which development tool to use**
Compare different development tools to see which suits Incomit best.
Prio: 1

Warf-R5. **Create an ESPA palette**
Create a palette that holds Incomit ESPA services, like Call Control, Messaging and Positioning.
Prio: 1
Warf-R6.  **Create an Utils palette**
Create a palette that holds Incomit utilities services, like DB, Log, Trace.
Prio: 1

Warf-R7.  **Drag 'n' drop Incomit iSea Call Control service**
Be able to drag 'n' drop Incomit iSea Call Control service from the Incomit ESPA palette to the current project.
Prio: 1

Warf-R8.  **Drag 'n' drop Incomit iSea Messaging service**
Be able to drag 'n' drop Incomit iSea Messaging service from the Incomit ESPA palette to the current project.
Prio: 1

Warf-R9.  **Drag 'n' drop Incomit iSea Positioning service**
Be able to drag 'n' drop Incomit iSea Positioning service from the Incomit ESPA palette to the current project.
Prio: 1

Warf-R10.  **Drag 'n' drop Incomit iSea DB service**
Be able to drag 'n' drop Incomit iSea DB service from the Incomit Utils palette to the current project.
Prio: 1

Warf-R11.  **Drag 'n' drop Incomit iSea Log service**
Be able to drag 'n' drop Incomit iSea Log service from the Incomit Utils palette to the current project.
Prio: 1

Warf-R12.  **Drag 'n' drop Incomit iSea Trace service**
Be able to drag 'n' drop Incomit iSea Trace service from the Incomit Utils palette to the current project.
Prio: 1
Warf-R13. **Incomit menu**
Create an Incomit menu containing deploy submenus.

Prio: 1

Warf-R14. **JAR Packager**
Be able to create an XML descriptor (not necessary automatically) and pack the created service into a JAR-file.

Prio: 1

Warf-R15. **Deploy to iSea**
Be able to deploy the created service directly to iSea using Incomit deployment tool.

Prio: 1

Warf-R16. **Help files**
Built in help files for the user. Be able to get help about the Incomit tools.

Prio: 3

**The iSea Service**

Warf-R17. **Create a service using iWarf**
Create a simple service that establishes a phone call, by using the service creation environment.

Prio: 1

**Installation**
Installation will be done with a simple batch file.
Platforms and compatibility

Environment:
Windows 2000 platform. For using iSea deployment tool, a connection to iSea is required.

Hardware:
Installation requires 50 MB of hard disk space.
Recommended configuration: 450MHz Pentium III, 256 MB RAM, and 256 paging file size.

Software:
Development tool and Java™ (TM) 2 SDK, Standard Edition, v. 1.3 (JDK 1.3) for Windows.

Human Engineering
Uniform look, that is to say buttons and fonts are similar in the program. Incomit style and colours wherever is possible.

Documentation
Bachelor's project specification
Timetable
Requirements specification
Bachelor's project documentation
Technical documentation (SDS)
Weekly reports
Diaries
B Code

B.1 iSeaClient_java

1. import com.incomit.slee.*;
2. 
3. /*
4. * __NAME__.java
5. *
6. * Created on __DATE__, __TIME__
7. *
8. * @author __USER__
9. */
10. 
11. public class __NAME_sleeClient__ implements ServiceDeployable {
12.    public __NAME_sleeClient__() {
13.       initComponents();
14.    }
15. 
16.    private void initComponents () {//GEN-BEGIN: initComponents
17.    //GEN-END: initComponents
18.    }
19. 
20.    public void activated() throws ServiceDeploymentException{
21.    }
22. 
23.    public void started() throws ServiceDeploymentException{
24.    }
25. 
26.    public synchronized void deactivated() throws ServiceDeploymentException{
27.        m_serviceContext = serviceContext;
28.    }
29. 
30.    public void stopped() throws ServiceDeploymentException{
31.    }
32. 
33.    public void setServiceContext(ServiceContext serviceContext) {
34.  }
35.
36.  // Components variables declaration - do not modify //GEN-BEGIN:variables
37.  // End of components variables declaration //GEN-END:variables
38.
39.  private ServiceContext m_serviceContext = null;
40.  }

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td><strong>NAME</strong> will be replaced with the chosen class name when using the template in NetBeans.</td>
</tr>
<tr>
<td>6.</td>
<td><strong>DATE</strong> and <strong>TIME</strong> will be replaced with the current date and time respectively when using the template in NetBeans.</td>
</tr>
<tr>
<td>8.</td>
<td><strong>USER</strong> will be replaced with your username when using the template in NetBeans.</td>
</tr>
<tr>
<td>11- 12.</td>
<td><strong>NAME_sleeClient</strong> will be replaced with the same as <strong>NAME</strong>. The extra _sleeClient is there to separate this class file from other template class files.</td>
</tr>
<tr>
<td>16- 18.</td>
<td>When dragging 'n' dropping a component from the Palette, the initialisation of the component takes place here because of the //GEN-BEGIN and //GEN-END.</td>
</tr>
<tr>
<td>36- 37.</td>
<td>When dragging 'n' dropping a component from the palette, the variable declaration of the component ends up here.</td>
</tr>
</tbody>
</table>

### B.2 ECall.java

1.  package com.incomit.espa.call;
2.
3.  public class ECall {
4.      public ECall() {
5.          }
6.
7.      public void addListener(String ecl) {
8.          System.out.println("addListener: " + ecl);
9.      }
10.
11.     public void addParticipant(String address) {
12.          System.out.println("addParticipant: " + address);
13.      }
public void createCall(String address) {
    System.out.println("createCall: " + address);
}

public void endCall() {
    System.out.println("endCall");
}

public String[] getParticipants() {
    return m_participants;
}

public void removeParticipant(String address) {
    System.out.println("removeParticipant: " + address);
}

private java.lang.String m_address;
private String[] m_participants = new String[] {"1","2");

B.3 HelloWorldPanel1.java

package com.incomit.iwarf.modules.wizards.helloworld;

import java.awt.Component;
import javax.swing.JLabel;
import javax.swing.JPanel;
import javax.swing.JTextField;
import java.awt.event.KeyAdapter;
import java.awt.event.KeyEvent;
import javax.swing.event.ChangeEvent;
import javax.swing.event.ChangeListener;
import javax.swing.event.EventListenerList;
import java.net.URL;
import java.net.MalformedURLException;
import org.openide.util.HelpCtx;
import org.openide.WizardDescriptor;

public class HelloWorldPanel1 extends JPanel implements WizardDescriptor.Panel {
    public void createCall(String address) {
        System.out.println("createCall: " + address);
    }

    public void endCall() {
        System.out.println("endCall");
    }

    public String[] getParticipants() {
        return m_participants;
    }

    public void removeParticipant(String address) {
        System.out.println("removeParticipant: " + address);
    }

    private java.lang.String m_address;
    private String[] m_participants = new String[] {"1","2");

B.3 HelloWorldPanel1.java

package com.incomit.iwarf.modules.wizards.helloworld;

import java.awt.Component;
import javax.swing.JLabel;
import javax.swing.JPanel;
import javax.swing.JTextField;
import java.awt.event.KeyAdapter;
import java.awt.event.KeyEvent;
import javax.swing.event.ChangeEvent;
import javax.swing.event.ChangeListener;
import javax.swing.event.EventListenerList;
import java.net.URL;
import java.net.MalformedURLException;
import org.openide.util.HelpCtx;
import org.openide.WizardDescriptor;

public class HelloWorldPanel1 extends JPanel implements WizardDescriptor.Panel {
public HelloWorldPanel1()
{
    URL url = null;
    try {
        url = new URL("nbresloc:/com/incomit/iwarf/
modules/wizards/resources/helloworld_panel1.html");
    } catch (MalformedURLException e) {
    }
    putClientProperty(“WizardPanel_helpURL”, url);
    putClientProperty("WizardPanel_contentSelectedIndex",
    new Integer(0));
    setLayout(null);
    addComponents();
    addActions();
}

private void addActions()
{
    jtf_hello.addKeyListener(new KeyAdapter()
    {
        public void keyReleased(KeyEvent evt)
        {
            fireChangeEvent();
        }
    });
}

private void addComponents()
{
    JLabel topInfo = new JLabel("Enter the secret
password in the textfield to continue.");
    jtf_hello = new JTextField("");
    add(topInfo);
    topInfo.setBounds(0,0,388,20);
    add(jtf_hello);
    jtf_hello.setBounds(0,44,388,20);
}

public void addChangeListener(ChangeListener l)
57.     listenerList.add (ChangeListener.class, l);
58. }
59.
60.   public Component getComponent() {
61.     return this;
62.   }
63.
64.   public HelpCtx getHelp() {
65.     return HelpCtx.DEFAULT_HELP;
66.   }
67.
68.   public boolean isValid() {
69.     if (jtf_hello.getText().toLowerCase().equals(MYSTRING)) {
70.       return true;
71.     } else {
72.       return false;
73.     }
74.   }
75.
76.   public void readSettings(Object settings) {
77. }
78.
79.   public void removeChangeListener(ChangeListener l) {
80. }
81.
82.   public void storeSettings(Object settings) {
83. }
84.
85.   private void fireChangeEvent() {
86.     ChangeEvent e = null;
87.     Object[] listeners = listenerList.getListenerList ();
88.     for (int i = listeners.length-2; i>=0; i-=2) {
89.       if (listeners[i]==ChangeListener.class) {
90.         if (e == null)
91.           e = new ChangeEvent
92.             ((ChangeListener)listeners[i+1]).stateChanged (e);
93.       }
94.     }
private JTextField jtf_hello;
private EventListenerList listenerList = new EventListenerList();
final static String MYSTRING = "hello world";

The panel will extend the JPanel and implement the NetBeans interface WizardDescriptor.Panel.
Specifies the path to the help file URL that appears in the step 1 of the wizard.
Adds the URL to the wizard using putProperty.
Sets this panel's position in the wizard. In this case it is the first panel and it means that it is at position 0. (Position 1 for step 2, position 2 for step 3, ...).
Sets the layout to null.
Adds a listener to the text field that listens for a key release. It will call the method fireChangeEvent if a key is pressed and released.
Adds a listener for changes to the listener list. This is for telling the main class that the password has been entered.
Return default help context because we do not need any help for this. We already have the html help file.
Returns true if the correct password is entered in the text field.
These methods implemented from the WizardDescriptor.Panel are not used here.
Fires a change event to tell all listeners that something has happened.
The secret password.

B.4 HelloWorldPanel2.java

package com.incomit.iwarf.modules.wizards.helloworld;
import java.awt.Component;
import javax.swing.JLabel;
import javax.swing.JPanel;
import javax.swing.event.ChangeListener;
import java.net.URL;
import java.net.MalformedURLException;
import org.openide.util.HelpCtx;
import org.openide.WizardDescriptor;

public class HelloWorldPanel2 extends JPanel implements WizardDescriptor.Panel {

    public HelloWorldPanel2() {
        URL url = null;
        try {
            url = new URL("nbresloc:/com/incomit/iwarf/modules/wizards/resources/helloworld_panel2.html");
        } catch (MalformedURLException e) {
            putClientProperty("WizardPanel_helpURL", url);
            putClientProperty("WizardPanel_contentSelectedIndex", new Integer(1));
        }
        setLayout(null);
        addComponents();
    }

    private void addComponents() {
        JLabel topInfo = new JLabel("Congratulations!!! You have entered the secret password!!!");
        add(topInfo);
        topInfo.setBounds(0, 0, 388, 20);
    }

    public void addChangeListener(ChangeListener l) {
    }
}
38.   public Component getComponent() {
39.     return this;
40.   }
41.
42.
43.   public HelpCtx getHelp() {
44.     return HelpCtx.DEFAULT_HELP;
45.   }
46.
47.   public boolean isValid() {
48.     return true;
49.   }
50.
51.   public void readSettings(Object settings) {
52.   }
53.
54.   public void removeChangeListener(ChangeListener l) {
55.   }
56.
57.   public void storeSettings(Object settings) {
58.   }
59. }

B.5 HelloWorld.java

1.   package com.incomit.iwarf.modules.wizards.helloworld;
2.
3.   import javax.swing.event.ChangeListener;
4.   import java.beans.PropertyChangeListener;
5.   import java.beans.PropertyChangeEvent;
6.   import java.text.MessageFormat;
7.   import org.openide.DialogDescriptor;
8.   import org.openide.NotifyDescriptor;
9.   import org.openide.TopManager;
10.  import org.openide.WizardDescriptor;
11.
12.  public class HelloWorld implements WizardDescriptor.Iterator {
13.    public HelloWorld(){
14.      panel1 = new HelloWorldPanel1();
15.      panel2 = new HelloWorldPanel2();
16.      panel1.setName(PANEL_NAMES[0]);
17.     panel2.setName(PANEL_NAMES[1]);
18.     panels = new WizardDescriptor.Panel[] {panel1, panel2};
19.
20.     wd = new WizardDescriptor(this);
21.     wd.putProperty("WizardPanel_autoWizardStyle", new Boolean(true));
22.     wd.putProperty("WizardPanel_contentDisplayed", new Boolean(true));
23.     wd.putProperty("WizardPanel_helpDisplayed", new Boolean(true));
24.     wd.putProperty("WizardPanel_contentNumbered", new Boolean(true));
25.     wd.putProperty("WizardPanel_contentData", new String[] {"Enter the first secret password.", "Result"});
26.     wd.setTitleFormat(new MessageFormat("{0}"));
27.     wd.setTitle("Hello World Wizard");
28.
29.     PropertyChangeListener listener = new
30.         PropertyChangeListener() {
31.             public void propertyChange(PropertyChangeEvent event) {
32.                 if (event.getPropertyName().equals(DialogDescriptor.PROP_VALUE)) {
33.                     Object option = event.getNewValue();
34.                     if (option == WizardDescriptor.FINISH_OPTION){
35.                         }
36.                 }
37.             }
38.         };
39.     wd.addPropertyChangeListener(listener);
40.     wd.setOptions (new Object[] {
41.         WizardDescriptor.PREVIOUS_OPTION, WizardDescriptor.NEXT_OPTION,
42.         WizardDescriptor.FINISH_OPTION, NotifyDescriptor.CANCEL_OPTION} );
43.     TopManager.getDefault().createDialog(wd).setVisible(true);
public WizardDescriptor.Panel current() {
    return panels[current_panel];
}

public boolean hasNext() {
    if (current_panel == 0) {
        return panel1.isValid();
    } else {
        return false;
    }
}

public boolean hasPrevious() {
    if (current_panel > 0) {
        return true;
    } else {
        return false;
    }
}

public String name() {
    return PANEL_NAMES[current_panel];
}

public void nextPanel() {
    current_panel++;
}

public void previousPanel() {
    current_panel--;
}

public void addChangeListener(ChangeListener l) {
}

public void removeChangeListener(ChangeListener l) {
}

static final int NR_OF_PANELS = 2;
```java
static final String[] PANEL_NAMES = {"Password step", "Final step");

private WizardDescriptor.Panel[] panels;
private WizardDescriptor wd;
private HelloWorldPanel1 panel1;
private HelloWorldPanel2 panel2;

private int current_panel = 0;
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.</td>
<td>The main class will extend the <code>WizardDescriptor.Iterator</code> interface that includes some useful methods for making this class a wizard.</td>
</tr>
<tr>
<td>14-15</td>
<td>Creates the two panels.</td>
</tr>
<tr>
<td>16-17</td>
<td>Set the names of the panels.</td>
</tr>
<tr>
<td>18.</td>
<td>Adds the panels to an array of <code>WizardDescriptor.Panels</code>. This is useful when having a lot of panels.</td>
</tr>
<tr>
<td>20.</td>
<td>Creates the <code>WizardDescriptor</code>.</td>
</tr>
<tr>
<td>21.</td>
<td>Turns on subtitle creation (the text above the panel).</td>
</tr>
<tr>
<td>22.</td>
<td>Turns on the displaying of the steps pane.</td>
</tr>
<tr>
<td>23.</td>
<td>Turns on the displaying of the help pane.</td>
</tr>
<tr>
<td>24.</td>
<td>Turns on the numbering of steps.</td>
</tr>
<tr>
<td>25.</td>
<td>Sets the steps name, which will be displayed, in the content pane.</td>
</tr>
<tr>
<td>26.</td>
<td>Sets the subtitle format. {0} is the name of the panel.</td>
</tr>
<tr>
<td>27.</td>
<td>Sets the title of the dialog.</td>
</tr>
<tr>
<td>29-39</td>
<td>Adds a listener for the buttons. In this case we listen for the <code>FINISH</code> button as an example of how you can do.</td>
</tr>
<tr>
<td>40.</td>
<td>Sets the buttons that will appear in the wizard.</td>
</tr>
<tr>
<td>41.</td>
<td>Shows the wizard dialog.</td>
</tr>
<tr>
<td>45.</td>
<td>Returns current panel.</td>
</tr>
<tr>
<td>48.</td>
<td>Return true here if the next button should be enabled.</td>
</tr>
</tbody>
</table>
Return true here if the previous button should be enabled.

Returns the name of the current panel.

When the next button has been hit this method will be called.

When the previous button has been hit this method will be called.

### B.6 HelloWorldWizardAction.java

```java
1. package com.incomit.iwarf.modules.menus.incomit;
2. 
3. import org.openide.util.HelpCtx;
4. import org.openide.util.NbBundle;
5. import org.openide.util.actions.CallableSystemAction;
6. import com.incomit.iwarf.modules.wizards.helloworld.HelloWorld;
7. 
8. public class HelloWorldWizardAction extends CallableSystemAction {
9.     public String getName () {
10.         return NbBundle.getBundle(HelloWorldWizardAction.class).
11.                 getString("LBL_HelloWorldWizardAction");
12.     }
13. 
14.     public HelpCtx getHelpCtx () {
15.         return HelpCtx.DEFAULT_HELP;
16.     }
17. 
18.     protected String iconResource () {
19.         return "/com/incomit/iwarf/modules/menus/resources/
20.                 HelloWorldWizardAction.gif";
21.     }
22. 
23.     public void performAction () {
24.         HelloWorld wizard = new HelloWorld();
25.     }
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>55.</td>
<td>Return true here if the previous button should be enabled.</td>
</tr>
<tr>
<td>57-64</td>
<td>Returns the name of the current panel.</td>
</tr>
<tr>
<td>67.</td>
<td>When the next button has been hit this method will be called.</td>
</tr>
<tr>
<td>70.</td>
<td>When the previous button has been hit this method will be called.</td>
</tr>
<tr>
<td>75.</td>
<td></td>
</tr>
</tbody>
</table>
Extends the CallableSystemAction class.

Returns the name taken from LBL_HelloWorldWizardAction property in the bundle file (Bundle.properties) in the incomit directory.

Returns the help context. If you do not have any help to return, use the HelpCtx.DEFAULT_HELP.

Here is the path to the icon that is shown in the menu. It is a 16x16 gif icon.

This method is called when the user clicks on the menu item.

Create and show a new HelloWorld wizard.

B.7 Example.java

```java
package com.incomit.iwarf.modules.fileapiexample;

import org.openide.filesystems.FileObject;
import org.openide.filesystems.Repository;
import org.openide.TopManager;
import java.net.URL;
import java.lang.Exception;
import java.io.File;
import org.openide.filesystems.LocalFileSystem;
import org.openide.filesystems.FileLock;
import org.openide.filesystems.FileAlreadyLockedException;
import org.openide.filesystems.FileLock;
import java.io.OutputStream;
import java.io.IOException;
import java.beans.PropertyVetoException;

public class Example {
    public Example() {
        this.fileDir = fileDir;
        if ((new File(fileDir)).isDirectory() == false)
            (new File(fileDir)).mkdirs();
        try {
            fs.setRootDirectory(new File(fileDir));
        } catch (PropertyVetoException e) {
            System.out.println("Vetoed by someone else");
        } catch (IOException e) {
            e.printStackTrace();
        } catch (PropertyVetoException e) {
```
System.out.println("Could not set Root Directory to fs");

e.printStackTrace();

try {
    file=fs.findResource(fileName);
    if (file == null) {
        file=fs.getRoot().createData(fileNameNoExtension, extension);
    } catch (IOException e) {
        System.out.println("Could not create file");
        e.printStackTrace();
    }
}

if (repo.findFileSystem(fs.getSystemName()) == null)
{
    repo.addFileSystem(fs);
}

private FileObject file;
private OutputStream outFile;
private Repository repo = TopManager.getDefault().getRepository();
private LocalFileSystem fs=new LocalFileSystem();
private String fileURL;
private String extension = new String("txt");
private String fileNameNoExtension = new String("myfile");
private String fileName = new String("myfile.txt");
private String fileDir = new String("c:\myfolder\");

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.</td>
<td>Sets the fileDir to c:\myfolder</td>
</tr>
<tr>
<td>18.</td>
<td>Check if fileDir is a valid folder (if it exist).</td>
</tr>
<tr>
<td>19.</td>
<td>Create fileDir if not exist. (the method mkdirs() can create folders recursively, for example, if you want to create the subfolder c:\myfolder\sub, and none of these exists, they will both be created)</td>
</tr>
</tbody>
</table>
We set the `fs` root directory to `c:\myfolder`.

Search for the file, `myfile.txt` in `fs`. On success, store the returned `FileObject` to `file`, else `file` will be null.

If file is null, create `myfile.txt` in `fs` root directory `c:\myfolder`.

Check if `fs` is mounted in the repository, if not add `fs` to the repository. This will make the filesystem, `fs`, visible in the NetBeans Explorer window.

### B.8 FileExampleAction.java

```java
package com.incomit.iwarf.modules.menus.incomit;

import java.awt.BorderLayout;
import java.awt.Dimension;
import java.awt.Color;
import javax.swing.JFrame;
import java.awt.Font;
import javax.swing.JLabel;
import javax.swing.SwingConstants;
import org.openide.util.HelpCtx;
import org.openide.util.NbBundle;
import org.openide.util.actions.CallableSystemAction;
import org.openide.windows.TopComponent;

public class FileExampleAction extends CallableSystemAction {

    public String getName () {
        return NbBundle.getBundle (FileExampleAction.class).getString ("LBL_FileExampleAction");
    }

    public HelpCtx getHelpCtx () {
        return HelpCtx.DEFAULT_HELP;
    }

    protected String iconResource () {
        return "/com/incomit/modules/menus/resources/FileExampleAction.gif";
    }
}
```
```java
public void performAction () {
    Example iExample = new Example();
}
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17-19</td>
<td>Gets the name (LBL_FileExampleAction) from the bundle file.</td>
</tr>
<tr>
<td>21-23</td>
<td>About the class HelpCtx, taken quoted from reference [3]:</td>
</tr>
<tr>
<td></td>
<td>&quot;Provides help for any window or other feature in the system. It is designed to be JavaHelp-compatible and to use the same tactics when assigning help to JComponent instances.&quot;</td>
</tr>
<tr>
<td></td>
<td>Look it up on the web if you need to have one. If you do not have a HelpCtx to return, just return the DEFAULT_HELP, as in this code.</td>
</tr>
<tr>
<td>25-27</td>
<td>Gets the URL to the icon used in the menu. This could actually also be fetched from the bundle file, as we did with the name. In this example both alternatives are shown.</td>
</tr>
</tbody>
</table>
C Descriptor wizard steps

This appendix explains the four steps for creating a descriptor file, using the descriptor wizard.

1. Basic service definition
   The user will fill out all, or some of these fields.
   - **Name (required)**
     The name the service will have in the SLEE.
   - **Version**
     The service version number.
   - **Company**
     The company that developed the service.
   - **Parent C.L.S.**
     Parent Class Loader Service. Sets the parent class loader of this service.
   - **Max alarms**
     Max number of alarms before the service will be shutdown.
   - **Trace**
     Turns logging to file on/off.

2. Service classes definition
   The user will fill out all, or some of these fields:
   - **Deployable (required)**
     Class that implements the deployable interface, needed for installation into iSea.
   - **Accessible**
     Class that implements the accessible interface, needed for outside access from a web page or servlet.
   - **Manageable**
     Class that implements the manageable interface, needed if the service should be managed from another application.
   - **Manageable_idl**
     Class that implements the manageable_idl interface. Describes the interface for the manageable object.
3. **Choose descriptor path**  
The user will browse to, or type in the path where the descriptor file will be stored. An exception will be thrown if the file is read-only, or locked by another program. The user will not get pass this step, until a legal path is entered.

4. **Manual edit**  
The generated descriptor file is shown for the user in a text-field. The user can edit the generated text, or choose finish to create the descriptor file. When the descriptor file is created, it will be added to the NetBeans Explorer window, so it can be accessed from the NetBeans IDE.